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Document Change Record 
This page records changes to this document. The document was 
originally released as Revision 001.

Version 
Number Date Description of Change

002 8/2007 Revised to add:
• information to support firmware release 2.0 

for the SR61, which is now available with a 
near-far range area imager.

• reading distance information for all scanner 
options.

• references to Intermec SmartWedge™.
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Before You Begin
This section provides you with safety information, technical 
support information, and sources for additional product 
information.

Safety Information
Your safety is extremely important. Read and follow all warnings 
and cautions in this document before handling and operating 
Intermec equipment. You can be seriously injured, and 
equipment and data can be damaged if you do not follow the 
safety warnings and cautions.

This section explains how to identify and understand warnings, 
cautions, and notes that are in this document.

Global Services and Support
Warranty Information
To understand the warranty for your Intermec product, visit the 
Intermec web site at www.intermec.com and click Support > 
Returns and Repairs > Warranty.

Disclaimer of warranties: The sample code included in this 
document is presented for reference only. The code does not 
necessarily represent complete, tested programs. The code is 
provided “as is with all faults.” All warranties are expressly 
disclaimed, including the implied warranties of merchantability 
and fitness for a particular purpose.

A warning alerts you of an operating procedure, practice, 
condition, or statement that must be strictly observed to avoid 
death or serious injury to the persons working on the 
equipment.

A caution alerts you to an operating procedure, practice, 
condition, or statement that must be strictly observed to 
prevent equipment damage or destruction, or corruption or 
loss of data.

Note: Notes either provide extra information about a topic or 
contain special instructions for handling a particular condition or 
set of circumstances.

http://www.intermec.com
http://www.intermec.com
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Web Support
Visit the Intermec web site at www.intermec.com to download 
our current documents (in PDF). To order printed versions of the 
Intermec manuals, contact your local Intermec representative or 
distributor.

Visit the Intermec support services knowledge base (Knowledge 
Central) at intermec.custhelp.com to review technical 
information or to request technical support for your Intermec 
product.

Telephone Support
These services are available from Intermec.

Services Description

In the U.S.A. and 
Canada call 1-800-
755-5505 and 
choose this option

Order Intermec 
products

• Place an order.
• Ask about an existing 

order.

1 and then choose 2

Order Intermec 
media

Order printer labels and 
ribbons.

1 and then choose 1

Order spare 
parts

Order spare parts. 1 or 2 and then 
choose 4

Technical 
Support

Talk to technical support 
about your Intermec 
product.

2 and then choose 2

Service • Get a return authorization 
number for authorized 
service center repair.

• Request an on-site repair 
technician.

2 and then choose 1

Service contracts • Ask about an existing 
contract.

• Renew a contract.
• Inquire about repair 

billing or other service 
invoicing questions.

1 or 2 and then 
choose 3

http://www.intermec.com
http://intermec.custhelp.com
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Outside the U.S.A. and Canada, contact your local Intermec 
representative. To search for your local representative, from the 
Intermec web site, click Contact.

Who Should Read This Guide
This guide is for the person who is responsible for installing, 
configuring, and maintaining the SR61. 

This guide provides you with information about the features of 
the SR61, and how to install, configure, operate, maintain, and 
troubleshoot it.

Before you work with the SR61, you should be familiar with your 
network and general networking terms, such as IP address. You 
should also be familiar with Bluetooth communications.

Related Documents
The Intermec web site contains Intermec documents (in PDF) 
that you can download for free. 

To download documents

1 Visit the Intermec web site at www.intermec.com.

2 Click Service & Support > Manuals.

3 In the Select a Product field, choose the product whose 
documentation you want to download.

To order printed versions of the Intermec manuals, contact your 
local Intermec representative or distributor.

http://www.intermec.com
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5,534,684; 5,536,924; 5,539,191; 5,541,419; 5,548,108; 
5,550,362; 5,550,364; 5,565,669; 5,572,007; 5,576,529; 
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6,149,063; 6,152,370; 6,155,490; 6,158,661; 6,164,542; 
6,164,545; 6,173,893; 6,195,053; 6,234,393; 6,234,395; 
6,249,008; 6,328,214; 6,330,975; 6,345,765; 6,356,949; 
6,367,699; 6,375,075; 6,375,076; 6,435,411; 6,484,944; 
6,641,046; 6,669,087; 6,681,994; 6,688,523; 6,732,930; 
6,879,428; 6,889,903; 6,974,085.

There may be other U.S. and foreign patents pending.
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1 Learning About the SR61

Use this chapter to familiarize yourself with the SR61 Cordless 
Scanner. This chapter covers these topics:

• Introducing the SR61 Cordless Scanner

• What’s New?

• Using the Battery

• How to Turn On the SR61

• Understanding the Lights

• Understanding the Beeps

• Scanning Bar Codes

• Using Vibrate Alert
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Introducing the SR61 Cordless Scanner
The SR61 Cordless Scanner is a small, rugged handheld scanner. 
The SR61 is lightweight, ergonomically designed, and uses a 
Bluetooth™ radio for RF communications.

SR61 Cordless Scanner

The SR61 comes with one of these scan engine options:

• 1D linear imager (SR61xV)

• 2D area imager (SR61xA)

• Laser scanner (SR61xL)

• Near-far range area imager (SR61xE)

SR61 Scan Engine Option: The scan engine option of your SR61 is the sixth 
character of the configuration number. In this illustration, the scan engine 
option is V or 1D linear imager.

For more information about the scanner options, see “Scanning 
Bar Codes” on page 8.

Battery

Intermec
Ready-to-Work
indicator

Status
light

Scanner

Trigger

XXXXXXXXXXXX
SN:   XXXXXXXXXXX

  CN:   SR61AV0100

Intermec Technologies Corp.    Everett, WA  98203
MODEL: SR61

MFD: XXXXXXXXX2XXX

BDA: xxxxxxxxxxxxxxxxx
Contains TX FCC ID: HN2-BTM311

IC: 1223A-BTM311

Made in Malaysia

MEX SCT RCPACBT05-068

Pat.

SR61AV0100
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What’s New?
This version of the user’s guide supports the firmware version 2.0 
release of the SR61 and includes these updates:

• Information to support the near-far range area imager option

• Minimum reading distance information for all scanner 
options

• Support for Intermec SmartWedge™, a software wedge tool 
that allows you to scan data directly to your host PC 
application

You can download the latest firmware version at no charge from 
the Intermec web site at www.intermec.com.

Using the Battery
The SR61 uses the AB3 lithium-ion battery as its main power 
source. You need to fully charge the battery before you can use 
the SR61.

Charging the Battery
Make sure you fully charge the battery before you start using the 
SR61.

To charge the battery

• Place the SR61 with the AB3 battery installed in the desktop/
wall mount 1-bay charger (AC5). 

Or,

• Remove the battery from the SR61, and insert the battery 
into the 2-bay, 4-bay, or 8-bay (AC6, AC7, or AC8) charger.

The battery pack used in this device may ignite, create a 
chemical burn hazard, explode, or release toxic materials if 
mistreated. Do not incinerate, disassemble, or heat above 
100°C (212°F). Charge only with Intermec Models AC5, AC6, 
AC7, and AC8. Do not short circuit; may cause burns. Keep 
away from children.

Use only Intermec battery pack Model AB3. Use of incorrect 
battery pack may present risk of fire or explosion. Promptly 
dispose of used battery pack according to the instructions.

http://www.intermec.com
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For more information, see the instructions that ship with the 
charger.

Checking the Battery Status
You can check your battery status at any time.

To check the battery status

• Pull the trigger.

If the status light on the SR61 turns red, the battery is low 
(less than 20% battery capacity remaining). You need to 
charge the battery now.

How to Turn On the SR61
You use the trigger to turn on the SR61.

To turn on the SR61

• Pull the trigger.

When you pull the trigger to turn on the SR61, the scanner 
enters a discoverable state and remains discoverable for about 5 
minutes. While the SR61 is discoverable and in communications 
range, your host Bluetooth device can discover your SR61 and 
establish a Bluetooth connection. 

If the status light on the SR61 turns red when you try to turn on 
the scanner, you need to charge the battery. For help, see 
“Charging the Battery” on page 3.

To turn off the SR61

• Scan this bar code:
Scanner Power Down

\60\08\2A\46

Note: If you have a near-far range imager, it may take up to 3 
seconds for the status light to turn on after you pull the trigger.
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Understanding the Lights
The lights on the SR61 indicate the status of the battery, a 
successful decode of a bar code, or the status of the Bluetooth 
connection.

SR61 Lights: The status light is either green or red, and the Intermec Ready-
to-Work™ indicator is blue.

Intermec
Ready-to-Work
indicator

Status light

Status Light Description

Light State What It Means

Blinks green one 
time

The SR61 successfully decoded a bar code and 
sent the data to the host.
The SR61 successfully scanned a configuration 
bar code.

Flashes red when 
you pull the trigger

The battery is low. You need to charge the 
battery.

Flashes red and 
stays on for 2 
seconds

You scanned a bar code, but the data was not sent 
to the host.
You scanned a configuration bar code and the 
SR61 did not accept it.

Note: When the SR61 is in the 1-bay charger, the status light 
indicates the battery charging status. For more information, see 
the instructions that ship with the charger.
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Understanding the Beeps
The SR61 beeps to give you audio feedback when performing 
some functions. For example, you hear a beep each time you scan 
a valid bar code.

Blue Intermec Ready-to-Work Indicator Description

Light State What It Means

On A Bluetooth connection with the host computer has 
been established. The SR61 is ready to scan bar codes 
and send data to the host computer.

Blinking The SR61 is trying to establish a Bluetooth connection 
with the host computer, or the SR61 is moving out of 
range of the host computer.

Off A Bluetooth connection to the host computer is not 
established. 

SR61 Beeps Description

Beep Sequence What It Means

Single beep The SR61 successfully decoded a bar code or 
scanned a configuration bar code.

Series of beeps from 
low to high

The SR61 connected to a Bluetooth host. 

Series of beeps from 
high to low

A Bluetooth connection has been lost.

Three beeps Data was not successfully sent to the host. The 
SR61 is out of range of the host.
A configuration bar code was not successfully 
scanned.

Continuous tone for 
several seconds

You just scanned the Administrator Reset 
Factory Defaults bar code and the non-volatile 
memory is being written. 
Do not remove the battery or place the SR61 
in a 1-bay charger until the tone stops. 
Otherwise, the firmware memory may be 
corrupted.
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You can change the beep volume for your needs and 
environment. You can set the beep volume to Low (quiet), 
Medium (loud), or High (very loud - default). 

To turn off the beeper

• Scan this bar code:
Beep Duration - 0

\60\03\11\21\00\00\00

You can also change the beeper duration and beeper frequency. 
For more information about the beeper commands, see 
Chapter 4, “Configuration Command Reference.”

Continuous beeping 
for 1 minute 

The host PC sent the Bluetooth Device Page 
command to the SR61. Once you find the 
misplaced SR61, pull the trigger to stop the 
beeps. For more information about paging the 
SR61, see “Paging the SR61” on page 29. 

Note: The SR61xV (linear imager) and SR61xL (laser scanner) 
may also produce a crackle sound when you scan a stacked (2D) 
bar code. For more information, see “Stacked Code Crackle” on 
page 51.

SR61 Beeps Description (continued)

Beep Sequence What It Means

Note: Turning off the beeper turns off only the bar code scanning 
beeps. The beeps for Bluetooth Connect/Disconnect and 
Bluetooth Device Page are not affected. 



Chapter 1 — Learning About the SR61

8 SR61 Cordless Scanner User’s Manual

Scanning Bar Codes

The SR61 contains either a 1D linear imager (SR61xV), 2D area 
imager (SR61xA), laser scan engine (SR61xL), or near-far range 
area imager (SR61xE) to scan bar code data. The type of scan 
engine you are using and the type of bar code you are decoding 
determines the way you scan the bar code.

When you unpack the SR61, these bar code symbologies are 
enabled: 

• Code 39

• Code 128 / EAN 128

• UPC/EAN

• PDF417

• DataMatrix (SR61xA and SR61xE only)

If you are using bar code labels that are encoded in a different 
symbology, you need to enable the symbology on your SR61. Use 
EasySet version 5.4.1 or later to enable and disable symbologies 
for your scanner. EasySet is available at no charge from the 
Intermec web site at www.intermec.com.

Before you can scan bar codes and send data to your data 
collection application, you need to establish a Bluetooth 
connection between your SR61 and the host device. For more 
information about establishing a Bluetooth connection, see 
“Connecting the SR61 to a Host Device” on page 14.

For the SR61xL and SR61xE, do not look directly into the 
window area or at a reflection of the laser beam or laser 
aiming beam while the laser is scanning. Long-term exposure 
to the laser beam can damage your vision.

http://www.intermec.com
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Scanning Bar Codes: The aiming and scanner beams that you see depend on 
whether you have a laser scanner (SR61xL), 1D linear imager (SR61xV), 2D 
area imager (SR61xA), or near-far range area imager (SR61xE).

To scan a bar code label with a laser scanner or 1D linear imager

1 Point the SR61 at the bar code label and hold the SR61 at a 
slight angle 15 to 25 cm (6 to 10 in) from the label. 

2 Pull the trigger, and direct the red beam so that it falls across 
all bars in the bar code label. 

Use this test bar code:

Code 39 Test Bar Code

*123456*
*123456*

Tip: Depending on your screen resolution, you may be able 
to scan bar codes displayed on your computer screen with the 
1D linear imager.

When the SR61 successfully reads a bar code label, the SR61 
creates a single high beep and the status light briefly turns 
green. If Vibrate Alert is enabled, the SR61 briefly vibrates.

3 Release the trigger.

ABCD

Status light

ABCDABCD



Chapter 1 — Learning About the SR61

10 SR61 Cordless Scanner User’s Manual

To scan omni-directionally with the 2D or near-far range area imager

1 Point the scanner window at the bar code label and hold the 
SR61 steady a few inches from the label.

2 Pull the trigger.

• If you are scanning with a 2D imager, center the red 
aiming beam over the bar code label.

• If you are scanning with a near-far range area imager, 
position the red aiming beam just to the right of the center 
of the bar code label.

3 The imager may flash repeatedly while it is trying to read a 
bar code. The aiming beam is smaller when the imager is 
closer to the bar code and larger when it is further away.

When the SR61 successfully reads a bar code label, the SR61 
creates a single high beep and the status light briefly turns 
green. If Vibrate Alert is enabled, the SR61 briefly vibrates.

4 Release the trigger.

Using Vibrate Alert
You can configure the SR61 to vibrate when it successfully 
decodes a bar code. This feature can be useful in these situations:

• You are in a noisy environment, such as a busy warehouse, 
where it can be difficult to hear the beep. 

• You are working in a quiet environment, such as a library, 
where you do not want to make a lot of noise.

To turn on vibrate alert

• Scan this bar code:
Turn On Vibrate Alert

\60\03\10\48\00\02\40
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To turn off vibrate alert

• Scan this bar code:
Turn Off Vibrate Alert

\60\03\10\48\00\00\00
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2 Connecting and Configuring 
the SR61

Use this chapter to understand how to connect the SR61 to a 
host device and configure the SR61 to communicate with your 
application. This chapter covers these topics:

• Connecting the SR61 to a Host Device

• Configuring the SR61 Parameters

• Configuring Bluetooth Communications
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Connecting the SR61 to a Host Device
You can use Bluetooth radio communications to connect up to 
seven SR61 scanners to: 

• an Intermec computer that is Bluetooth-enabled. For help, see 
“Connecting to an Intermec Computer” on page 15.

• a PC with a USB Bluetooth adapter (P/N 203-771-xxx) or 
RS-232 Bluetooth adapter (P/N 203-768-xxx). For help, see 
“Connecting to a Host PC With the USB or RS-232 
Bluetooth Adapter” on page 16.

• other Bluetooth-enabled devices that support Serial Port 
Profile (SPP). For help, see the instructions for your 
Bluetooth-enabled device.

Before connecting the SR61 to a host device, note the Bluetooth 
address for the:

• host Bluetooth device.

• SR61.

SR61 Bluetooth Address: The SR61 Bluetooth address is located in the top 
right corner of the label on the side of the SR61.

To connect to a host device, you may need to install EasySet, the 
Intermec configuration application that allows you to change 
settings on the SR61. For the SR61, you need EasySet version 
5.4.1 or later. You can download EasySet at no charge from the 
Intermec web site at www.intermec.com.

XXXXXXXXXXXX
SN:   XXXXXXXXXXX

  CN:   XXXXXXXXX

Intermec Technologies Corp.    Everett, WA  98203
MODEL: SR61

MFD: XXXXXXXXX2XXX Contains TX FCC ID: HN2-BTM311
IC: 1223A-BTM311

Made in Malaysia

MEX SCT RCPACBT05-068

Pat.

Bluetooth
address

BDA: xxxxxxxxxxxx
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Connecting to an Intermec Computer

1 Turn on the SR61 by pulling the trigger.

2 Scan the Bluetooth association bar code label that ships with 
your Intermec computer. If you do not have a Bluetooth 
association bar code label for your Intermec computer, use 
EasySet to create a Bluetooth connect bar code. For help, see 
the EasySet software.

Tip: Depending on your screen resolution, you may be able 
to scan this bar code displayed on your computer screen with 
an SR61xA, SR61xV, or SR61xE.

The SR61 beeps once, the green status light flashes once, and 
the blue Intermec Ready-to-Work™ indicator starts blinking. 
On your Intermec computer, the Authen. Request dialog box 
appears.

3 In the Enter PIN field, enter the default PIN (0000) and 
select OK. 

When the SR61 connects to your Intermec computer, the 
SR61 emits a series of beeps from low to high, and the blue 
Intermec Ready-to-Work indicator turns on and stays on. The 
SR61 is ready to scan data.

4 Repeat Steps 1 to 3 to connect up to seven SR61s to the 
Intermec computer.

Note: When you first connect to an Intermec computer, only 
SR61 settings common to the Intermec computer’s internal 
scanner settings are changed to the internal scanner’s default 
settings.

Note: You can also use the Intermec Bluetooth Scanner Wizard 
on the Intermec computer. For help, see the documentation for 
your Intermec computer.
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Connecting to a Host PC With the USB or RS-232 Bluetooth Adapter
1 Install the USB Bluetooth adapter (P/N 203-771-xxx) or 

RS-232 Bluetooth adapter (P/N 203-768-xxx) and software 
on your host PC.

2 Connect and pair up to seven SR61s with your host PC.

For help, see the instructions that ship with the adapter.

To disconnect from a host PC

• Scan this bar code:

Bluetooth Device Disconnect 

\60\02\52\05\00\00\06\00\00\00\00\00\00\00\00\00

The SR61 disconnects from your host PC, emits a series of 
beeps from high to low, and the blue Intermec Ready-to-
Work indicator turns off.

Connecting as a Keyboard Wedge
You can connect your SR61 to your host PC as a keyboard 
wedge. Connecting as a keyboard wedge lets your host PC receive 
data from the SR61 as it would from a keyboard. You can use one 
of these applications:

• Intermec SmartWedge™ is a software wedge tool that allows 
you to scan data directly to your host PC application and 
configure the SR61 scanner from the PC using Intermec 
Settings. SmartWedge runs on Microsoft® Windows® XP with 
SP2. For help, see the instructions that ship with 
SmartWedge.

• Keyport Lite is a keyboard wedge application that supports 
English QWERTY keyboards. Keyport Lite runs on 
Microsoft Windows 98 and 2000. For help, see the next 
section procedure, “To connect using Keyport Lite.”

To order Intermec SmartWedge or Keyport Lite, contact your 
local Intermec representative.
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To connect using Keyport Lite

1 Connect your SR61 to your host PC running Microsoft 
Windows 98 or 2000. For help, see the previous section, 
“Connecting to a Host PC With the USB or RS-232 
Bluetooth Adapter.”

2 Install Keyport Lite on your PC.

3 Start Keyport Lite. From the Window menu, select Change 
Registration. The Registration Form appears.

4 Fill in the information on the Registration Form, and click 
OK.

5 From the Window menu, select Options. The Options 
window appears.
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6 In the Port field, select the COM port being used for 
Bluetooth communications, and click OK.

7 Click the Start button. Your SR61 is connected to your host 
PC as a keyboard wedge.

For more information about Keyport Lite, see the documentation 
that ships with the product.

Collecting Data With Your SR61
After you connect your SR61 to a host device, you are ready to 
start collecting data. The data collection method you use depends 
on whether you are using:

• an Intermec computer.

• a host PC.

• the SR61 as a keyboard wedge.

To collect data with your SR61

1 Establish a Bluetooth connection.

2 Start your data collection application.

3 For a host PC:

• If necessary, configure your data collection application to 
receive data from the incoming or outgoing COM port.

Or, 

• If necessary, connect your SR61 to your host PC as a 
keyboard wedge. For help, see “Connecting as a Keyboard 
Wedge” on page 16.

4 Scan a bar code with your SR61. The data is entered into your 
application.

For more information, see “Connecting the SR61 to a Host 
Device” on page 14.

Note: You can use either the incoming or outgoing (client or 
server) COM port.
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Configuring the SR61 Parameters
You can configure many parameters on the SR61, such as the bar 
code symbologies it decodes or the volume of the beeper. These 
characteristics are controlled by configuration commands. The 
values you set for these configuration commands determine how 
the scanner operates. 

You can configure the SR61:

• using EasySet version 5.4.1 or later. For help, see the next 
section, “Configuring the SR61 With EasySet.”

• remotely from your Intermec computer. For help, see 
“Configuring the SR61 From Your Intermec Computer” on 
page 21.

• remotely from your host PC using Intermec SmartWedge. For 
help, see the instructions that ship with SmartWedge.

Configuring the SR61 With EasySet
EasySet is an Intermec configuration application that provides 
you with two ways to configure the SR61:

• Send configuration commands from EasySet directly to the 
SR61.

• Send configuration commands to a bar code setup sheet. You 
can scan the bar codes onscreen with your SR61xA, SR61xV, 
or SR61xE or you can print the setup sheet and scan the bar 
codes. You do not need a Bluetooth connection to use this 
method.

To configure the SR61 by sending commands from EasySet

1 Establish a Bluetooth connection with your host PC.

2 Start EasySet. The first time you start EasySet, the Select 
product dialog box appears.

If the Select product dialog box does not appear, choose 
Product > Select.

3 Select the SR61.

4 Select Communication > Connect. The Online Setup dialog 
box appears.
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5 Select the COM port that your SR61 is using for Bluetooth 
communications, and click OK. 

EasySet connects to your SR61 and retrieves the current 
configuration of the SR61. This configurations are indicated 
with blue text.

6 In the Commands window, choose configuration command 
settings for your SR61.

Your SR61 is updated with the new configuration command 
settings, and the settings are added to the bar code setup sheet.

To configure the SR61 by scanning bar codes

1 Start EasySet. The first time you start EasySet, the Select 
product dialog box appears.

If the Select product dialog box does not appear, choose 
Product > Select.

2 Select the SR61.

3 In the Commands window, choose configuration command 
settings for your SR61 and add them to the bar code setup 
sheet.

4 Scan the bar codes onscreen with your SR61xA, SR61xV, or 
SR61xE, or print the setup sheet and scan the commands. 
When you scan bar code configuration commands, the SR61 
emits a series of beeps unless the volume is turned off.

• One beep means you scanned a valid configuration 
command.

• Three beeps means you scanned an invalid configuration 
command.

For more information about EasySet, see the EasySet software. 
For descriptions of the configuration commands, see Chapter 4, 
“Configuration Command Reference.”

Note: The SR61 does not beep when you send configuration 
commands online from EasySet.
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Configuring the SR61 From Your Intermec Computer
You can configure many settings for the SR61 from your 
Intermec computer. For descriptions of the configuration 
commands, see Chapter 4, “Configuration Command 
Reference.”

To configure the SR61 from your Intermec computer

1 Establish a Bluetooth connection with your Intermec 
computer.

2 On your Intermec computer, start the Intermec Settings 
application.

3 Select Data Collection > SR61 Scanner Bluetooth Address, 
where Bluetooth Address is the Bluetooth address of your 
SR61. The SR61 Bluetooth address is located in the top right 
corner of the label on the side of the SR61.

4 Configure commands from the SR61 Scanner menu for your 
SR61.

5 Select File > Save Settings. The SR61 is updated with the 
new configuration command settings.

6 Close Intermec Settings.

Restoring Default Settings
You can restore the SR61 to its default settings by scanning the 
Administrator Reset Factory Defaults bar code. For a list of the 
default settings, see “Configuration Commands By Function” 
on page 35.

Note: When you first connect to an Intermec computer, only 
SR61 settings common to the Intermec computer’s internal 
scanner settings are changed to the internal scanner’s default 
settings.

Note: The Administrator Reset Factory Defaults command resets 
all parameters. When you scan this bar code, you will lose 
Bluetooth communications.
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To restore default settings

• Scan this bar code:
Administrator Reset Factory Defaults

\60\08\55\22

Configuring Bluetooth Communications
The SR61 can communicate with a host device through 
the Bluetooth communications Serial Port Profile (SPP). SPP 
allows your SR61 to use the Bluetooth link as a serial port to 
communicate with your host device. You can send information 
from the SR61 to your serial application without having to 
modify your application.

You can initiate a Bluetooth connection from either your SR61 
or host device:

• SR61-initiated Bluetooth connection.

• Host device-initiated Bluetooth connection.

Configuring Security
The SR61 provides Bluetooth wireless security for transmitting 
data. By default, security is active on your SR61. For maximum 
security, you need to configure a Bluetooth PIN (personal 
identification number).

This section assumes that you have already installed EasySet 
version 5.4.1 or later.

After you scan the Administrator Reset Factory Defaults bar 
code, the SR61 produces a continuous tone while writing to 
the non-volatile memory. Do not remove the battery or place 
the SR61 in a 1-bay charger until the tone stops. Otherwise, 
the firmware memory may be corrupted.
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To configure a Bluetooth PIN for your SR61

1 Start EasySet.

2 In the Commands window, select Data transmission settings 
> Bluetooth parameters > security.

3 Select active.

4 Select compose PIN and create a Bluetooth PIN that is up to 
16 characters in length. The default Bluetooth PIN is 0000.

5 Scan both the active and compose PIN configuration bar 
codes onscreen with your SR61xA, SR61xV, or SR61xE, or 
print the bar code setup sheet and scan both bar codes.

Configuring the Discoverable State of the SR61
By default, the SR61 is always discoverable. For enhanced 
security, you should configure your SR61 for limited 
discoverability, which allows the SR61 to be discoverable by 
Bluetooth management applications for only 30 seconds. For 
more information, see “Bluetooth Discoverable” on page 41.

To configure your SR61 for limited discoverability

• Scan this bar code:

Bluetooth parameters - discoverable - limited

\60\02\50\41\00\02\40

The SR61 is discoverable for 30 seconds. 

Note: For security reasons, you can only change the Bluetooth 
PIN by scanning a bar code.
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3 Troubleshooting and 
Maintaining the SR61

Use this chapter to solve problems you may have while using the 
SR61. This chapter contains these topics: 

• Troubleshooting the SR61

• Maintaining the SR61
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Troubleshooting the SR61
If you have problems using the SR61, use this chapter to find a 
possible solution.

Calling Product Support
To talk to an Intermec Product Support representative, call:

1-800-755-5505

Before you call Intermec Product Support, make sure you have 
the following information:

• Product version

• Sub-system versions

• Bluetooth address of your SR61

To get the product version, sub-system versions, or Bluetooth address

1 If necessary, install the USB Bluetooth adapter (P/N 203-
771-xxx) or RS-232 Bluetooth adapter (P/N 203-768-xxx) 
and create a Bluetooth connection between your SR61 and 
PC. For help, see the instructions that ship with the adapter.

2 Run an application that can accept bar code information from 
the SR61, such as HyperTerminal.

3 Scan one of these bar codes:
Get Product Version

\60\0F\37\20
Get Sub-System Versions

\60\0F\37\24

Get SR61 Bluetooth Device Address

\60\0F\37\23
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Tip: Depending on your screen resolution, you may be able 
to scan these bar codes displayed on your computer screen 
with an SR61xA, SR61xV, or SR61xE.

Problems and Possible Solutions
Some possible solutions recommend scanning the Administrator 
Reset Factory Defaults bar code. Please read the following 
caution and note about this command.

After you scan the Administrator Reset Factory Defaults bar 
code, the SR61 produces a continuous tone while writing to 
the non-volatile memory. Do not remove the battery or place 
the SR61 in a 1-bay charger until the tone stops. Otherwise, 
the firmware memory may be corrupted.

Note: The Administrator Reset Factory Defaults command resets 
all parameters. When you scan this bar code, you will lose 
Bluetooth communications.

Problem Possible Solution

You cannot establish a 
Bluetooth connection (the blue 
Intermec Ready-to-Work 
indicator is not on).

Scan the following bar code to reset the scanner to its default 
configuration and try establishing a connection again.
Administrator Reset Factory Defaults

\60\08\55\22
You misplaced your SR61 and 
you need to find it.

If your SR61 is within Bluetooth communication range of 
your host PC, you can send the Bluetooth Device Page 
command from EasySet to locate your SR61. For help, see 
“Paging the SR61” on page 29.

When you pull the trigger, the 
Status light flashes red.

The battery is low. Charge the battery immediately, and then 
try scanning again.

When you pull the trigger, the 
red scanner beam does not turn 
on.

The battery is low. Charge the battery immediately, and then 
try scanning again.

The blue Intermec Ready-to-
Work indicator is blinking.

The SR61 is trying to establish a Bluetooth connection with 
the host computer, or the SR61 is moving out of range of the 
host computer.
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You are trying to establish a 
Bluetooth connection from a 
host device to your SR61, but 
the host device cannot find 
your SR61.

The SR61 may not be in a discoverable state. For help, see 
“Bluetooth Discoverable” on page 41.
The SR61 may be connected and paired to another Bluetooth 
device. Scan the following bar code to reset the SR61 to its 
default settings and disconnect Bluetooth communications. 
Try establishing a connection again.
Administrator Reset Factory Defaults

\60\08\55\22
You established a Bluetooth 
connection with an Intermec 
computer, and the settings on 
your SR61 were restored to 
their default values.

When you first connect to an Intermec computer, only SR61 
settings common to the Intermec computer’s internal scanner 
settings are changed to the internal scanner’s default settings. 
Scan configuration bar codes, or use Intermec Settings on your 
Intermec computer to change your SR61 settings.

You changed the Bluetooth PIN 
from its default value of 0000, 
but you forgot your new PIN 
number.

Scan this bar code to reset the scanner to its default 
configuration and default Bluetooth PIN of 0000.
Administrator Reset Factory Defaults

\60\08\55\22
You pull the trigger to scan a 
data bar code, the SR61 does 
not beep, and the scanner beam 
starts blinking.

The data may still be in the process of being sent to the host. 
Data transmission may be slow if there is interference with 
Bluetooth communications or if the SR61 is too far from the 
host device. If you are using Level Trigger Mode, the scanner 
beam blinks while the SR61 is waiting. For more information, 
see “Trigger Mode” on page 53.

You scan a bar code, the Status 
light flashes red for two 
seconds, and the scanner beeps 
three times.

The SR61 may not be connected to a host. Make sure the blue 
Intermec Ready-to-Work indicator is on and the SR61 is 
connected to your host device. For help, see “Connecting the 
SR61 to a Host Device” on page 14.

You are using the SR61 in 
keyboard wedge mode, and 
when you try to scan a bar code, 
nothing happens.

Try these possible solutions:
• Make sure that your data collection application is open and 

running.
• If you are using Keyport Lite, make sure that you pressed 

the Start button.
For help, see “Connecting as a Keyboard Wedge” on page 16.

Problem Possible Solution
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Resetting the SR61
If your SR61 does not respond when you pull the trigger, you can 
reset your SR61. When you reset your SR61, the scanner control 
firmware is restarted. 

To reset your SR61

• Remove and install the AB3 battery from the SR61.

If you have a Bluetooth connection, the SR61 disconnects from 
the host device. After a reset, the SR61 tries to reestablish a 
Bluetooth connection with the host device. 

Paging the SR61
If you have misplaced your SR61, but your SR61 is turned on 
and within Bluetooth communication range of your host PC, 
you can send the Bluetooth Device Page command from EasySet 
to find your SR61.

To page the SR61

1 Start EasySet version 5.4.1 or later.

2 Select Communication > Connect.

3 Select the COM port that your SR61 is using for Bluetooth 
communications, and click OK.

4 Select the Send to product check box below the commands 
window.

5 In the EasySet Commands window, select Configuration 
modes and utilities > Bluetooth device page. 

Your SR61 beeps continuously either for 1 minute or until 
you find your SR61 and pull the trigger.

Note: By default, the Bluetooth Device Page command is 
disabled. You need to enable the command on the SR61 before 
you can use it. For help, see the EasySet software version 5.4.1 or 
later.
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Maintaining the SR61
To keep your SR61 in good working order, you may need to 
upgrade the SR61 firmware and clean the scanner window.

Upgrading the SR61
When you upgrade your SR61 firmware, you update the SR61 
processor firmware as well. The current settings are erased and 
replaced with the default settings for the SR61. You need to 
reestablish Bluetooth communications between your SR61 and 
other Bluetooth devices and applications in your data collection 
system. 

To upgrade the SR61 firmware, you need these items:

• Interlink firmware upgrade application

• SR61 firmware upgrade package:

• Firmware upgrade file (.ldr) 

• Upgrade instructions (readme.txt)

• Full firmware version text file (.txt)

• PC running Microsoft® Windows® XP with SP2 or Microsoft 
Windows 2000

• USB Bluetooth adapter (P/N 203-771-xxx)

Before upgrading the SR61, you need to:

• fully charge the SR61 battery. For help, see “Charging the 
Battery” on page 3.

• download the latest SR61 firmware upgrade package and 
Interlink firmware upgrade application from the Intermec 
web site at www.intermec.com.

a Go to Service & Support > Downloads.

b From the Select A Product drop-down list, choose Bar 
Code Scanners: SR61 Cordless Scanner.

Note: The SR61 firmware cannot be upgraded using the 
RS-232 Bluetooth adapter (P/N 203-768-xxx) to connect to 
the host PC.

http://www.intermec.com
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c Click the link to download the SR61 firmware upgrade 
package or the Interlink firmware upgrade application, 
and save it to your PC.

d Unzip the .zip file.

• If the SR61 is in the 1-bay charger, remove it from the 
charger.

• If necessary, install the USB Bluetooth adapter on your PC. 
For help, see the instructions that ship with the adapter.

• Make sure that all applications on your PC are closed.

To upgrade the SR61

1 Start Interlink.

2 Scan the Administrator Reset Factory Defaults bar code on 
screen, or below, and click Next:
Administrator Reset Factory Defaults

\60\08\55\22

3 Click Browse to go to the location of the firmware upgrade 
file (.ldr).

4 Select the firmware file, click Open, and then click Next.

5 Pull the trigger to turn on your SR61. The SR61 enters a 
discoverable state and remains discoverable for about 5 
minutes. 

If you have a near-far range imager, it may take up to 3 
seconds for the status light to turn on after you pull the 
trigger

6 If you are running Microsoft Windows XP with SP2, enter 
the Bluetooth address of your SR61, and click Next. 
Your SR61 connects to the host PC, emits a series of beeps 
from low to high, and the blue Intermec Ready-to-Work 
indicator turns on and stays on. 
The status bar appears, and Interlink upgrades your SR61 
with the firmware file you selected. Interlink notifies you 
when the upgrade is complete. Continue with Step 8.
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7 If you are running Microsoft Windows 2000:

a Create a Bluetooth connection between your SR61 and 
host PC. For help, see the instructions that ship with the 
USB Bluetooth adapter.

When your SR61 connects to the host PC, your SR61 
emits a series of beeps from low to high, and the blue 
Intermec Ready-to-Work indicator turns on and stays on.

b From the drop-down list box, select the COM port that 
the SR61 is using for Bluetooth communications.

c Click Next. 

The status bar appears, and Interlink upgrades your SR61 
with the firmware file you selected. Interlink notifies you 
when the upgrade is complete.

8 Click Quit.

Cleaning the SR61
Clean the scanner window as often as needed for the 
environment in which you are using the SR61. To clean the 
scanner window, you can use soapy water, a solution of ammonia 
and water, or isopropyl alcohol.

To clean the scanner window 

1 Dip a clean towel or rag in soapy water, ammonia and water 
solution, or isopropyl alcohol and wring out the excess. Wipe 
the scanner window. Do not allow any abrasive material to 
touch the window.

2 Wipe dry with a lint-free cloth.

Note: If you have a near-far range imager, after a firmware 
upgrade, you need to pull the trigger, wait for about 3 seconds, 
and then pull the trigger again.

Opening the SR61 will void the warranty and may cause 
damage to the internal components.
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4 Configuration Command 
Reference

Use this chapter to learn about the configuration commands 
supported on the SR61. This chapter contains these topics:

• Using Configuration Commands

• Configuration Commands By Function

• SR61 Configuration Commands
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Using Configuration Commands
A configuration command changes the way the SR61 operates. 
For example, you can change the Beep Volume and make the 
SR61 beeper very quiet.

You can configure the SR61:

• by sending commands to your SR61 from your PC using 
EasySet.

• by sending commands to a bar code setup sheet. Then, scan 
the bar codes onscreen with your SR61, or print the setup 
sheet and scan the bar codes. You do not need a Bluetooth 
connection to use this method.

• from your Intermec computer. Send commands to your SR61 
from your Intermec computer using Intermec Settings.

• remotely from your host PC using Intermec SmartWedge. For 
help, see the instructions that ship with SmartWedge.

For a list of all the commands and their default values as they are 
organized in EasySet, see the next section, “Configuration 
Commands By Function.”

For descriptions of each command organized alphabetically, see 
“SR61 Configuration Commands” on page 39.

Note: When you first connect to an Intermec computer, only 
SR61 settings common to the Intermec computer’s internal 
scanner settings are changed to the internal scanner’s default 
settings.
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Configuration Commands By Function
The configuration commands are grouped by function and 
reflect the organization of the Commands window in EasySet.

Reset All Parameters

Command Default Value See Page

Administrator reset factory defaults N/A 39
User reset factory defaults N/A 55

Data Transmission Settings

Bluetooth Command Default Value See Page

Bluetooth security Active 42
Bluetooth PIN 0000 42

Bluetooth discoverable Fully discoverable 41
Bluetooth pageable mode Not active 41
Bluetooth profile Serial port profile (SPP) 42
Bluetooth device name SR61 Scanner <Bluetooth 

Address>
41

Bluetooth connect/disconnect Disconnect 40

Data Transmission 
Command Default Value See Page

Data editing N/A 45
Postamble <CR><LF> 49
Preamble None 49
Symbology identifier Not transmitted 51
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Symbology Settings

Symbology Default Value See Page

Disable all symbologies N/A 46
Australian Post Not active 39
Aztec Not active 39
BPO Not active 42
Canada Post Not active 42
Codabar Not active 43
Codablock

Codablock A Not active 43
Codablock F Not active 43

Code 11 Not active 43
Code 39 Active 43
Code 93/93i Not active 43
Code 128 / EAN 128 Active 44

ISBT 128 Active 44
GTIN processing Not active 44

DataMatrix Active 45
Dutch Post Not active 46
EAN.UCC Composite Not active 46
Interleaved 2 of 5 Not active 47
Japan Post Not active 47
Matrix 2 of 5 Not active 48
Maxicode Not active 48
Micro PDF417 Not active 48
MSI Not active 48
PDF417 Active 48
Planet Not active 49
Plessey Not active 49
Postnet Not active 49
QR Code Not active 50
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RSS
RSS 14 Not active 50
RSS Expanded Not active 50
RSS Limited Not active 50

Standard 2 of 5 Not active 51
Telepen Not active 52
TLC 39 Not active 52
UPC/EAN Active 54

ISBN Not active 54
GTIN processing Not active 55

Symbology Settings (continued)

Symbology Default Value See Page

Operating Settings

Trigger Activation Command Default Value See Page

Trigger mode Level 53
Trigger timeout 2 sec 54
Turn off after good read Active 54

Data Decoding
Security Command Default Value See Page

Predefined security levels Normal 50
Consecutive same read 
data validation

Auto read count 
before transmission

45

Timeout between identical 
consecutive codes

300 ms 52

Timeout between different 
consecutive codes

None 52
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Operating Settings (continued)

Beeps/Green Indicator LED 
Command Default Value See Page

Beep volume High 40
Note (Beep frequency) 2610 Hz 40
Good read beeps

Number 1 47
Duration 80 ms 47
Timing After transmission 47

Good read LED duration 2000 ms 47
Error beep On 46
Setup beep On 51
2D symbologies

Stacked code crackle On 51
Vibrate alert

Vibrate alert Off 55
Duration 300 ms 55

Sensor Optimization and 
Imager Settings Command Default Value See Page

Sensor optimization Automatic 50
Imager settings

Decode mode 2D imager 45
Lighting goal 40 47
Aimer flashing mode Aimer off during 

frame acquisition
39

Configuration Modes and Utilities

Command Default Value See Page

Configuration modes and 
utilities

Configuration 
Enabled

45

Bluetooth device page N/A 41
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SR61 Configuration Commands
This section lists the configuration commands in alphabetical 
order and provides a description of each command. To configure 
your SR61 using these commands, see the EasySet software.

Administrator Reset Factory Defaults
Causes the SR61 to perform a restart and restores all 
configuration commands to their default settings, including the 
Bluetooth PIN. When you restore all configuration commands to 
their default settings, you need to reestablish Bluetooth 
communications.

Aimer Flashing Mode
SR61xA (area imager) and SR61xE (near-far range area imager) 
only. By default, the SR61 aimer beam flashes repeatedly while 
the imager attempts to read a bar code. The aimer beam flashes 
on so that you can see where to aim the SR61 and flashes off to 
read the bar code (with the least amount of interference from the 
light of the aimer beam). You can change this default setting so 
that the aimer is always on.

Australian Post
SR61xA (area imager) and SR61xE (near-far range area imager) 
only. Enables or disables decoding of Australian Post symbology. 
Australian Post is a 4-state bar code that allows Australian Post to 
sort incoming mail using a bar code. There are three types of bar 
codes corresponding to FCC values 11, 59, and 62. BarDIMM 
only needs the DPID and Customer information, and 
automatically generates all the other information like the FCC or 
Reed-Solomon checksum.

Aztec
SR61xA (area imager) and SR61xE (near-far range area imager) 
only. Enables or disables decoding of Aztec symbology. Aztec is a 
2D matrix symbology made up of square modules on a square 
grid, with a square bulls eye pattern at their center. Aztec Code 
symbols can encode large amounts of data with user-defined 
error-correction level.
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Beep Duration
Sets the length of the beeps. You can set Beep Duration to a value 
from 0 to 2550 ms. When Beep Duration is set to 0 ms, the 
beeper is off. Turning off the beeper does not affect the beeps 
associated with Bluetooth Connect/Disconnect or Bluetooth 
Device Page.

Use Beep Duration in combination with Beep Frequency and 
Beep Volume to define beeps according to operator preference 
and work environment.

Beep Frequency
Sets the frequency, or pitch, of the beeps. You can set Beep 
Frequency to a value from 1000 to 5110 Hz.

Use Beep Frequency in combination with Beep Volume and 
Good Read Beep Duration to define beeps according to operator 
preference and work environment.

Beep Volume
Adjusts the volume of the beeps. You can set Beep Volume to 
Low, Medium, or High.

Use Beep Volume in combination with Beep Frequency and 
Good Read Beep Duration to define beeps according to operator 
preference and work environment.

Bluetooth Connect/Disconnect
Connects or disconnects Bluetooth communications between the 
SR61 and host computer using Serial Port Profile (SPP).

To connect to a host computer, enter the Bluetooth address of the 
computer and scan the bar code with the SR61. To disconnect, 
scan the disconnect bar code.

Note: To turn off the beeper, set the Beep Duration to 0. Turning 
off the beeper does not affect the beeps associated with Bluetooth 
Connect/Disconnect or Bluetooth Device Page.
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Bluetooth Device Name
Assigns the name to the scanner. If the scanner is in a 
discoverable state, its Bluetooth device name is available to 
host computers during device discovery.

Bluetooth Device Page
If your SR61 is within Bluetooth communication range of the 
host PC and Bluetooth Pageable Mode is enabled, you can page 
the SR61 from EasySet. For help, see “Paging the SR61” on 
page 29.

Bluetooth Discoverable
Determines the discoverable state of your SR61. When your 
SR61 is discoverable, it is visible to other Bluetooth devices in 
communication range.

Bluetooth Pageable Mode
Enables or disables the Bluetooth Device Page command. 
With Bluetooth Pageable Mode enabled, the SR61 maintains 
Bluetooth communication with the host device so that you can 
use the Bluetooth Device Page command to locate the SR61. For 
help, see “Paging the SR61” on page 29.

With Bluetooth Pageable Mode disabled, the SR61 turns off and 
disconnects after 30 minutes of inactivity. Disabling Bluetooth 
Pageable Mode also saves battery power.

Bluetooth Discoverable States

State Description

Fully Your SR61 is discoverable to Bluetooth management 
applications.

Limited Your SR61 is discoverable to Bluetooth management 
applications for 30 seconds.

Not Your SR61 is not discoverable to Bluetooth management 
applications.

Note: Your SR61 is not discoverable by other Bluetooth devices 
while connected to a host device.
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Bluetooth PIN
When Bluetooth security is enabled, the Bluetooth PIN is used to 
authenticate the Bluetooth link and encrypt the data. Depending 
on the Bluetooth software on your host device, you should only 
need to enter the Bluetooth PIN the first time you connect and 
pair the SR61.

For help configuring a Bluetooth PIN, see “Configuring 
Security” on page 22.

Bluetooth Profile
Configures the SR61 to connect to a host device through the 
Serial Port Profile (SPP) Bluetooth communications profile. SPP 
allows the SR61 to use the Bluetooth link as a serial port to 
communicate with the host device.

For more information, see “Configuring Bluetooth 
Communications” on page 22.

Bluetooth Security
Enables or disables Bluetooth security. When Bluetooth security 
is enabled, you need to enter the SR61 Bluetooth PIN before you 
can use the scanner. For more information, see “Configuring 
Security” on page 22.

BPO
SR61xA (area imager) and SR61xE (near-far range area imager) 
only. Enables or disables decoding of BPO (British Post Office) 
4-state bar code symbology. BPO was developed by the British 
Post office for encoding European postcode data similar to the 
way the U.S. Postnet symbology is used for encoding Zip Code 
data. BPO provides European countries with a simple and 
efficient postal bar coding scheme.

Canada Post
SR61xA (area imager) and SR61xE (near-far range area imager) 
only. Enables or disables decoding of Canada Post 4-state bar 
code symbology. Canada Post contains addressing as well as 
customer-specific information. Canada Post sends mail pieces 
through Canada Post’s integrated distribution system in the most 
cost-efficient way.
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Codabar
Enables or disables decoding of Codabar symbology. Codabar 
is a self-checking, discrete symbology. The American Blood 
Commission (ABC) Codabar requires that you retain and 
transmit the start/stop code digits when processing a Codabar 
symbol. As a result, configuration CD10 is an illegal 
configuration. 

Codablock A
Enables or disables decoding of Codablock A symbology. 
Codablock A is a 2D bar code that is an extension of Code 39. 
If Code 39 is enabled with check digit, you cannot enable 
Codablock A. For best results, disable Code 39 before you enable 
Codablock A. If Code 39 is enabled with check digit, Codablock 
A will not be decoded properly.

Codablock F
Enables or disables decoding of Codablock F symbology. 
Codablock F is a 2D bar code that is an extension of Code 128. If 
Code 128 is enabled with check digit, you cannot enable 
Codablock F. For best results, disable Code 128 before you 
enable Codablock F.

Code 11
Enables or disables decoding of Code 11 symbology. Code 11 is a 
very high-density, discrete numeric bar code used extensively in 
labeling telecommunications components and equipment.

Code 39
Enables or disables decoding of Code 39 symbology. Code 39 is 
discrete, variable length, and self-checking. The character set is 
uppercase A to Z, 0 to 9, dollar sign ($), period (.), slash (/), 
percent (%), space ( ), plus (+), and minus (-).

Code 93/93i
Enables or disables decoding of Code 93/93i symbology. Code 
93/93i is a variable length, continuous symbology that uses four 
element widths.
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Code 128 / EAN 128
Enables or disables decoding of Code 128 / EAN 128 symbology. 
Code 128 is a very high-density alphanumeric symbology that 
supports the extended ASCII character set. It is a variable length, 
continuous code that uses multiple element widths.

Code 128 supports the following function codes.

ISBT 128
Enables and configures decoding of ISBT Code 128 symbology. 
ISBT Code 128 is the global bar code labeling standard for the 
blood banking industry and is used to support the worldwide 
distribution, tracking, and handling of blood bags and blood 
components.

GTIN Processing for EAN 128
With Global Trade Item Number (GTIN) processing enabled, a 
GTIN-compliant EAN 128 label will strip the first two digits 
output 14 digits.

GTIN-compliant EAN 128 labels:

• are 16 digits long.

• have "01" as the first two digits of the label.

Code 128 Function Codes

Function Code Description

FNC1 FNC1 is used as a separator when multiple 
identifiers and their fields are concatenated. For 
example, FNC1 can be useful in keyboard wedge 
mode when the GS character cannot be 
transmitted.

FNC2 When the FNC2 character occurs in a bar code, the 
SR61 temporarily stores the data from the bar code 
and transmits it as a prefix to the next symbol. In 
this way, FNC2 can be used to concatenate several 
symbols before the data is transmitted.
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Configuration Modes and Utilities
Use Configuration Modes and Utilities to:

• allow the SR61 to always accept configuration commands by 
scanning bar codes or to timeout 1 minute after the last 
configuration command is set by scanning a bar code.

• get the product version, sub-system versions, and Bluetooth 
address of your SR61. 

• page the SR61 from the host PC or turn off the SR61.

For more information and bar codes, see “Troubleshooting the 
SR61” on page 26.

Consecutive Same Read Data Validation
To ensure you have a valid read before transmitting data, you can 
set the SR61 to scan a bar code multiple times.

You can set Consecutive Same Read Data Validation from 0 to 
10. The default value of 0 sets the scanner to automatically adapt 
to the consecutive same read based on the bar code quality and 
the trust level of the bar code. For example, labels with a check 
digit require fewer reads than labels without a check digit.

Data Editing
Data editing allows you to edit data scanned by the SR61 before 
it is transmitted to the host. You can define up to seven input 
scenarios to filter the data you want to edit. For more 
information, see the EasySet software.

DataMatrix
SR61xA (area imager) and SR61xE (near-far range area imager) 
only. Enables or disables decoding of DataMatrix symbology, a 
high density 2D matrix code that can store a large amount of 
information. DataMatrix has excellent error correction abilities 
and is mostly used for marking and tracking parts.

Decode Mode
SR61xA (area imager) and SR61xE (near-far range area imager) 
only. Sets the imager decode mode to linear imager emulation 
(1D) or 2D imager mode. 
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2D imager mode allows you to hold the SR61xA or SR61xE in 
any direction and perform a good read, regardless of the 
orientation of the bar code. The ability to read bar codes in any 
direction lets you use a comfortable and ergonomic hand 
position. 

Linear imager emulation allows you to increase your imaging 
performance (similar to a laser scanner), but requires that you 
hold the SR61xA or SR61xE horizontal to the 1D bar code label. 

Disable All Symbologies
This command disables all symbologies. However, disabling all 
symbologies does not reset symbology parameters to their default 
values. To reset all symbology parameters to their default factory 
settings, use the Administrator Reset Factory Defaults command. 
For more information, see “Administrator Reset Factory 
Defaults” on page 39.

Dutch Post
SR61xA (area imager) and SR61xE (near-far range area imager) 
only. Enables or disables decoding of Dutch Post symbology. 
Dutch Post is a 4-state bar code that contains addressing, as well 
as customer-specific information.

EAN.UCC Composite
Enables or disables European Article Numbering Universal 
Character Coding (EAN.UCC) Composite symbology. An 
EAN.UCC Composite symbol consists of a linear component 
(encoding the item’s primary identification) associated with an 
adjacent 2D Composite Component (encoding supplementary 
data, such as a batch number or expiration date). The Composite 
symbol always includes a linear component to ensure that the 
primary identification is readable by all scanning technologies, 
and so that 2D imagers can use the linear component as a finder 
pattern for the adjacent 2D Composite Component.

Error Beep
Enables or disables the error beep. Your SR61 emits an error beep 
without affecting the configuration of your SR61, when you scan 
a configuration bar code that is damaged or unknown.
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Good Read Beep Duration
Sets the length of the SR61 good read beeps. You can set Good 
Read Beep Duration to a value from 0 (off ) to 2550 ms.

Use Good Read Beep Duration in combination with Beep 
Volume and Beep Frequency to define beeps according to 
operator preference and work environment.

Good Read Beep Number
Establishes the number of beeps used for the good read beep: 
one, two, or none. 

Good Read Beep Timing
Sets the good read beep to occur either before or after successfully 
transmitting data. 

Good Read LED Duration
Sets the amount of time the green Status light stays on after a 
good read. You can set Good Read LED Duration to a value from 
0 (off ) to 5110 ms. When the Status light is on due to a long 
duration setting, the SR61 can still read new bar codes and 
receive commands. 

Interleaved 2 of 5
Enables or disables decoding of Interleaved 2 of 5 symbology. 
Interleaved 2 of 5 is a high-density, self-checking, continuous 
numeric symbology mainly used in inventory distribution and 
the automobile industry.

Japan Post
SR61xA (area imager) and SR61xE (near-far range area imager) 
only. Enables or disables decoding of Japan Post 4-state code 
symbology. Japan Post is a simple and efficient postal bar coding 
scheme.

Lighting Goal
SR61xA (area imager) and SR61xE (near-far range area imager) 
only. The lighting goal is the average light intensity that the SR61 
tries to achieve when capturing an image. Do not change this 
setting without assistance from a representative from the 
Intermec Engineering Department.



Chapter 4 — Configuration Command Reference

48 SR61 Cordless Scanner User’s Manual

Matrix 2 of 5
Enables or disables decoding of Matrix 2 of 5 symbology. Matrix 
2 of 5 is a discrete bar code derived from Code 11.

China Post is available as part of the Matrix 2 of 5 symbology 
start/stop code. China Post encodes 11 digits with no check digit 
and has unique start and stop patterns.

Maxicode
SR61xA (area imager) and SR61xE (near-far range area imager) 
only. Enables or disables decoding of Maxicode symbology. 
Maxicode is a fixed 2D symbology that contains an array of 
hexagons arranged around a circular pattern. Maxicode is mostly 
used in package sorting and tracking applications.

Micro PDF417
Enables or disables decoding of Micro PDF417 symbology. 
Micro PDF417 is a multi-row symbology based on PDF417, 
designed to maximize area efficiency for applications that do not 
need the maximum data capacity of PDF417. Micro PDF417 
contains a limited set of symbol sizes that each includes a fixed 
level of error correction.

MSI
Enables or disables decoding of MSI symbology. MSI code is 
similar to Plessey code in that it includes a start pattern, data 
characters, one or two check digits, and a stop pattern. 

PDF417
Enables or disables decoding of PDF417 symbology. The 
PDF417 symbology is a stacked 2D symbology that allows you to 
scan across rows of code. Each row consists of start/stop 
characters, row identifiers, and symbol characters (which consist 
of four bars and four spaces each and contain the actual data). 
This symbology uses error-correction symbol characters 
appended at the end to recover loss of data.

Macro PDF417, a feature of PDF417, extends the capability of 
PDF417 by allowing up to 99,999 PDF417 symbols to be used 
to store data. The symbols are concatenated as they are scanned 
and can be scanned in any order.
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Planet
SR61xA (area imager) and SR61xE (near-far range area imager) 
only. Enables or disables decoding of Planet symbology. The 
United States Postal Service (USPS) uses a combination of two 
tracking numbers (the Postnet code and Planet code) to track a 
customer’s piece of mail. A Planet symbol has 12 or 14 digits.

Plessey
Enables or disables decoding of Plessey symbology. Plessey code is 
pulse-width modulated like most other bar codes and includes a 
start character, data characters, an eight-bit cyclic check digit, a 
termination bar, and usually a reverse start character. The code is 
continuous and not self-checking. You need to configure two 
parameters for Plessey code: Start Code and Check Digit.

Postamble
Sets the postamble that is appended to any data you scan. 
Common postambles include cursor controls such as a tab or a 
carriage return line feed. You can set up to 20 ASCII characters 
for Postamble. 

Postnet
SR61xA (area imager) and SR61xE (near-far range area imager) 
only. Enables or disables decoding of Postal Numeric Encoding 
Technique (Postnet) symbology. The Postnet bar code was 
invented by the United States Postal Service (USPS) to encode 
ZIP information. Enabling your letter printing system as Postnet-
capable allows you to receive a discount on postage. The U.S.A. 
delivery address coding can be of three forms (1) 5-digit ZIP; (2) 
5-digit ZIP + 4 code (3) 11-digit delivery point code. So a valid 
Postnet bar code contains either 32 bars, 52 bars or 62 bars. 
Postnet is a numeric symbology. Different from most other 
symbologies, Postnet has requirements to the actual bar height 
and width. The information is encoded in the height and has 
nothing to do with the spaces. 

Preamble
Sets the preamble that precedes any data you scan. Common 
preambles include a data location number or an operator 
number. You can set Preamble to up to 20 ASCII characters.
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Predefined Security Levels
Defines the security level to use when decoding bar codes. When 
you select a lower decode security level, the SR61 can decode bar 
codes with poorer print quality.

QR Code
SR61xA (area imager) and SR61xE (near-far range area imager) 
only. Enables or disables decoding of QR Code symbology. QR 
Code is a 2D matrix symbology containing dark and light square 
data modules. 

RSS 14
Enables or disables decoding of Reduced Space Symbology (RSS) 
14 1D or stacked 2D codes. RSS 14 is a numeric symbology that 
can read stacked omni-directional bar code labels. It is a member 
of the EAN.UCC RSS symbology family.

RSS Expanded
Enables or disables decoding of Reduced Space Symbology (RSS) 
Expanded. RSS Expanded is an alphanumeric symbology that 
can read RSS limited and stacked bar code labels. It is a member 
of the EAN.UCC RSS symbology family. 

RSS Limited
Enables or disables decoding of Reduced Space Symbology (RSS) 
Limited. RSS Limited is a numeric symbology that does not read 
stacked bar code labels. It is a member of the EAN.UCC RSS 
symbology family. 

Sensor Optimization
SR61xV (linear imager) only. Sets the linear imager configuration 
for the type of bar code being scanned. If you are going to scan 
only standard 1D bar codes or only stacked 2D bar codes, you 
can set Sensor Optimization to 1D or 2D for optimal imager 
performance.

Note: To read RSS 14 stacked 2D codes, RSS Expanded or RSS 
Limited must also be enabled.
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Setup Beep
Enables or disables the setup beep. When you successfully scan 
a configuration bar code, you hear the setup beep, and the 
configuration of the SR61 is changed. 

Stacked Code Crackle
SR61xV (linear imager) and SR61xL (laser scanner) only. Enables 
or disables the crackle sound when you scan a stacked (2D) bar 
code. 

Standard 2 of 5
Enables or disables decoding of Standard 2 of 5 symbology. 
Standard 2 of 5 is a low-density numeric symbology that encodes 
all information in the bars separated by fixed-width spaces. 
Standard 2 of 5 is used in warehouse sorting, photofinishing, and 
airline ticketing. 

Symbology Identifier
Symbology identifiers allow you to indicate the type of data being 
sent by prepending an identifier. You can prepend one of the 
following types of character strings to identify which symbology 
the data is using. 

Symbology Identifier Options

Character 
String Description

AIM identifier The AIM Standard for symbology identifiers 
consists of a three-character structure indicating the 
symbology and the optional features of the 
symbology. For more information about the AIM 
Standard for symbology identifiers, refer to the AIM 
ISO/IEC Standard.

User-defined 
symbology 
identifier (UDSI)

The user-defined symbology identifier (UDSI) is 
one to four ASCII characters in length. You can 
configure user-defined symbology identifiers to 
assign custom identifier strings to the bar code 
symbologies.

Code mark Enables the code mark symbology identifier for all 
symbologies.
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Telepen
Enables or disables decoding of Telepen symbology. Telepen is 
the only symbology to directly represent the full ASCII character 
set without shift characters. Considered extremely secure, 
Telepen has negligible risk of misreads and a double-density 
numeric only mode. 

Timeout Between Different Consecutive Codes
This command invalidates a second bar code read before the 
timeout expires. Use this command when consecutively scanning 
bar codes that contain different data, as opposed to the Timeout 
Between Identical Consecutive Codes command. 

You can set Timeout Between Different Consecutive Codes to a 
value from 0 to 2550 ms.

Timeout Between Identical Consecutive Codes
This command invalidates a second bar code read before the 
timeout expires. Use this command when consecutively scanning 
bar codes with identical data, as opposed to the Timeout Between 
Different Consecutive Codes command. 

You can set Timeout Between Identical Consecutive Codes to a 
value from 0 to 2550 ms.

TLC 39
TLC 39 is a composite symbology designed for the 
Telecommunications Industry. TLC 39 combines a Code 39 
symbol that encodes a part number (for items such as plug-in 
boards at central switching stations) with a linked MicroPDF417 
symbol that encodes a serial number and other optional 
information.

The first six characters must be numeric and include the ECI 
number. The seventh character is a delimiter between the linear 
data portion and the composite data portion, typically a comma, 
although other delimiters are allowed. The next piece of data is a 
mandatory unique Serial Number.

There can be other data fields after the Serial Number, usually 
either AppIDs or DataIDs, which are governed by whether or not 
there are alpha characters in the serial number. Country Of 
Origin is another typical data field included in this symbology.
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Trigger Mode
SR61xV (linear imager), SR61xA (area imager), and SR61xE 
(near-far range area imager) only. Trigger mode allows you to set 
different types of triggering options for the imager. For more 
information, see the next table.

Trigger Mode Options

Mode Description

Continuous/
Edge

When you pull the trigger, the red scanner beam 
turns and stays on. When you pull the trigger a 
second time, the scanner beam turns off. Simply 
releasing the trigger does not turn off the scanner.

Level When you pull the trigger, the red scanner beam 
turns on and stays on until you release the trigger 
or until the SR61 successfully decodes a bar code.
When you scan a data (versus configuration) bar 
code, data transmission may be slow if there is 
interference with Bluetooth communications, or 
if the SR61 is too far from the host device. The 
scanner beam blinks while the SR61 is waiting to 
transmit data. During this time, you can scan 
configuration bar codes but not data bar codes. 
When the SR61 receives acknowledgement from 
the host, the scanner turns off, and the SR61 
beeps.

Pulse When you pull the trigger, the red scanner beam 
turns on. The scanner remains on until the 
Trigger Timeout period is reached.

Flashing When you pull the trigger, the red scanner beam 
turns on and the SR61 checks for a bar code to 
read. The scanner starts flashing when the Trigger 
Timeout period is reached. When the SR61 finds 
and reads a bar code, it resets the Trigger Timeout 
period. If you pull the trigger a second time, the 
scanner beam turns off.

Autostand Autostand mode allows you to switch between 
level mode and flashing mode. The first time you 
pull the trigger, the scanner beam turns on and 
the scanner is in flashing mode. Switch to level 
mode by pulling the trigger again. If the scanner is 
idle and the Trigger Timeout period is reached, 
the scanner returns to flashing mode.
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Trigger Timeout
SR61xV (linear imager), SR61xA (area imager), and SR61xE 
(near-far range area imager) only. Sets the trigger timeout for the 
Trigger Mode command. You can set trigger timeout from 1 to 
4095 seconds. 

Turn Off After Good Read
Sets how the SR61 operates in level and pulse trigger modes. 

UPC/EAN
Enables or disables decoding of Universal Product Code (UPC)/
European Article Numbering (EAN) symbology. UPC/EAN are 
fixed-length, numeric, continuous symbologies that use four 
element widths. A scanner that is configured to decode EAN bar 
codes can decode UPC, but the reverse is not true. UPC code is a 
subset of EAN code. 

ISBN
International Standard Book Number (ISBN) is a 10-digit 
symbology that uniquely identifies books for tracking and 
ordering. 

Aim Aim triggering allows you to turn on the scanner 
and aim the red scanner beam without causing a 
decode. Releasing the trigger enables the decode.

Trigger Mode Options (continued)

Mode Description

Trigger 
Mode

Turn Off After 
Good Read SR61 Behavior

Level Enabled The SR61 turns off after it successfully 
reads a bar code.

Level Disabled The SR61 stays on until you release the 
Scan button.

Pulse Enabled The SR61 turns off after it successfully 
reads a bar code.

Pulse Disabled The SR61 stays on until the Trigger 
Timeout period is reached.
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With ISBN enabled, the first three characters (978) are ignored, 
and the checksum is calculated on the remaining characters.

GTIN Processing
With Global Trade Item Number (GTIN) processing enabled, 
two zeros are padded to the beginning of UPC-A, and one zero is 
padded to the beginning of EAN-13 to expand the numbers to 
14 digits. To use GTIN processing you also need to enable the 
corresponding UPC/EAN symbology. 

User Reset Factory Defaults
SR61xV (linear imager), SR61xA (area imager), and SR61xL 
(laser scanner) only. Causes the SR61 to perform a restart and 
restores all configuration commands to their default settings, only 
if no settings are locked. To reset all settings on the SR61, 
including locked settings, use the Administrator Reset Factory 
Defaults command. For more information, see “Administrator 
Reset Factory Defaults” on page 39.

When you restore all configuration commands to their default 
settings, you need to reestablish Bluetooth communications.

Vibrate Alert
Enables or disables the vibrate alert. When Vibrate Alert is 
enabled, the scanner vibrates when you scan a valid bar code.

Vibrate Alert Duration
Sets the amount of time that the vibrate alert remains on. You can 
set Vibrate Alert Duration to a value from 0 to 2550 ms. 
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Specifications
Use this section to find technical information about the SR61.

Physical Dimensions
Length: 12.7 cm (5 in)
Height: 19.3 cm (7.6 in)
Width: 6.9 cm (2.7 in)
Weight: 390 g (13.8 oz)

Power and Electrical Specifications
Operating: Rechargeable lithium-ion battery
Electrical rating:  x 5V, 1.7A

Temperature and Environmental Specifications
Operating: -20°C to 50°C (-4°F to 122°F) 
Storage: -20°C to 60°C (-4°F to 140°F)
Charging: 0°C to 35°C (32°F to 95°F)
Relative humidity: 0 to 95% non-condensing
Environmental rating: IP54

Bluetooth Radio
Radio Type: Bluetooth Class 1 version 1.2

Frequency: 2.4 GHz

Radio Data Rate: 721 Kbits per second

Communication Range
Host radio Class 1: 30.5 m (100 ft)

Host radio Class 2: 10 m (32.8 ft)

Features: Adaptive Frequency Hopping (ADF)
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Bar Code Symbologies

* = These symbologies are only available on the SR61xA (2D area 
imager) and SR61xE (near-far range area imager).

• Australian Post* • Maxicode*
• Aztec* • Micro PDF417
• BPO* • MSI
• Canada Post* • PDF417
• Codabar • Planet*
• Codablock A • Plessey
• Codablock F • Postnet*
• Code 11 • QR Code*
• Code 39 • RSS 14
• Code 93/93i • RSS 14 Stacked
• Code 128 / EAN 128 • RSS Limited
• DataMatrix* • RSS Expanded
• Dutch Post* • Standard 2 of 5
• EAN.UCC Composite • Telepen
• Interleaved 2 of 5 • TLC 39
• Japan Post* • UPC/EAN
• Matrix 2 of 5
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Scan Engines

EV10 1D Linear Imager (SR61xV) 
Scan rate: 200 scans per second

Scan range: up to 50 cm (19.7 in)

Scan angle: 40°

Minimum X dimension: 4 mils (0.1 mm)

Minimum Reading Distances With 0.255 cm (0.100 in) Setback

Symbology
Bar Code 
Contents Density

Minimum 
Distance*

Maximum 
Distance

Code 39 RESO 0.100 MM 0.1 mm 
(4 mils)

11.255 cm 
(4.400 in)

13.745 cm 
(5.400 in)

R 0.125 MM 0.125 mm 
(5 mils)

10.255 cm 
(4.000 in)

16.745 cm 
(6.600 in)

0.25 0.25 mm 
(10 mils)

6.255 cm 
(2.500 in)

23.745 cm 
(9.300 in)

0.5 0.5 mm 
(20 mils)

4.255 cm 
(1.700 in)

30.745 cm 
(12.100 in)

R1MM 1 mm 
(40 mils)

7.755 cm 
(3.100 in)

39.745 cm 
(15.600 in)

UPC/EAN 120010010100 0.33 mm 
(13 mils)

5.455 cm 
(2.100 in)

25.745 cm 
(10.100 in)

PDF417 10 mils 0.254 mm 
(10 mils)

10.255 cm 
(4.000 in)

16.745 cm 
(6.600 in)

15 mils 0.381 mm 
(15 mils)

8.255 cm 
(3.200 in)

18.745 cm 
(7.400 in)

*Minimum reading distances are measured in the dark (0 lux).
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Linear Imager Minimum Reading Distances: This graphic does not include 
the 0.255 cm (0.100 in) setback for the SR61.
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EL20 Laser Scanner (SR61xL) 

Scan rate: 500 scans per second

Scan angle: 38 degrees

Minimum X dimension: 4 mils (0.1 mm)

Minimum Reading Distances With 0.260 cm (0.102 in) Setback

Symbology Density Minimum Distance* Maximum Distance

Code 39 0.125 mm (5 mils) 9.760 cm (3.802 in) 18.740 cm (7.398 in)

0.25 mm (10 mils) 7.260 cm (2.802 in) 38.740 cm (15.198 in)

0.5 mm (20 mils) 9.260 cm (3.602 in) 79.740 cm (31.398 in)

1 mm (40 mils) 10.260 cm (4.002 in) 131.740 cm (51.898 in)
1.3 mm (51 mils) 41.260** cm (16.202 in) 149.740 cm (58.898 in)

UPC/EAN 0.33 mm (13 mils) 6.760 cm (2.702 in) 47.740 cm (18.798 in)
*Minimum reading distances are measured in the dark (0 lux).
**Depends on symbology length and scan angle.
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Standard Range Laser Scanner Minimum Reading Distances: This 
graphic does not include the 0.260 cm (0.102 in) setback for the SR61.
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EA11 2D Area Imager (SR61xA)

Frame rate: 30 to 60 frames per second

Scan angles: 38.9° horizontal
25.4° vertical
45.5° diagonal

Dynamic range: 60 dB linear
80 dB to 100 dB high dynamic

Minimum Reading Distances With 0.180 cm (0.071 in) Setback

Symbology Density Minimum Distance* Maximum Distance

Code 39 0.125 mm (5 mils) 7.580 cm (2.971 in) 12.220 cm (4.729 in)
0.20 mm (8 mils) 4.380 cm (1.671 in) 21.020 cm (8.229 in)
0.25 mm (10 mils) 3.680 cm (1.471 in) 25.320 cm (9.829 in)
0.5 mm (20 mils) 5.280 cm (2.071 in) 40.620 cm (15.829 in)

UPC/EAN 0.33 mm (13 mils) 5.180 cm (2.071 in) 29.820 cm (11.629 in)
Data Matrix 0.191 mm (7.5 mils) 6.680 cm (2.571 in) 16.420 cm (6.429 in)

0.254 mm (10 mils) 5.180 cm (2.071 in) 20.80 cm (8.129 in)
0.381 mm (15 mils) ** 27.820 cm (10.229 in)

PDF417 0.160 mm (6.6 mils) 6.480 cm (2.571 in) 14.020 cm (5.429 in)
0.254 mm (10 mils) 4.880 cm (1.871 in) 21.820 cm (8.529 in)
0.381 mm (15 mils) 5.280 cm (2.071 in) 33.620 cm (13.129 in)

*Minimum reading distances are measured in the dark (0 lux).
**Depends on symbology length and scan angle.
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2D Area Imager Minimum Reading Distances: This graphic does not 
include the 0.180 cm (0.071 in) setback for the SR61.

8"

4"

6"

2"

0"

2"

4"

in

6"

8"

10"

10"

cm

10

5

0

5

10

15

20

20

15

25

25

0 5040302010

0" 16"12"8"4"

0.125mm / 5mils

0.25 mm / 10 mils

0.5 mm / 20 mils

Data Matrix 7.5 mils

100% contrast UPC EAN

PDF417 6.6 mils



Appendix A — Specifications and Accessories

66 SR61 Cordless Scanner User’s Manual

EX25 Near-Far Range Area Imager (SR61xE)

Frame rate 
(decoded mode): up to 56 frames per second

Scan angles: 12.2° horizontal
7.8° vertical
17° diagonal

Light source angles:13° horizontal
11° vertical
14.4° diagonal

Light source: 650 nm laser (aiming beam and auto focus)
617 nm highly visible LED (lighting system)

1D Symbologies Minimum Reading Distances With 0.325 cm (0.128) Setback

Symbology Density Minimum Distance* Maximum Distance

Code 39 0.1 mm (3.8 mils) 18.325 cm (7.218 in) 31.675 cm (12.472 in)
0.25 mm (10 mils) 18.325 cm (7.218 in) 68.675 cm (27.032 in)
0.5 mm (20 mils) 19.325 cm (7.608 in) 109.675 cm (43.182 in)
1 mm (40 mils) 40.325 cm (15.878 in) 219.675 cm (86.482 in)
1.3 mm (51 mils) 100.325 cm (39.498 in) 309.675 cm (121.922 in)
2.5 mm (100 mils) 130.325 cm (51.308 in) 429.675 cm (169.162 in)

EAN 100% 0.33 mm 22.325 cm (7.998 in) 99.675 cm (39.242 in)
*Minimum reading distances are measured in the dark (0 lux).



Appendix A— Specifications and Accessories 

SR61 Cordless Scanner User’s Manual 67

Accessories for the SR61
You can use these accessories (sold and ordered separately) with 
the SR61. To order accessories, contact your local Intermec sales 
representative.

Accessories for the SR61

Accessory Description

SR61 Battery The SR61 battery (AB3) provides power to the 
SR61.

Desktop/
Wallmount 1-Bay 
Charger

The 1-bay charger (AC5) charges the AB3 battery 
while the battery is installed in the SR61.

Desktop/
Wallmount 1-Bay 
Charger Power 
Supply

This power supply provides AC power to the 1-bay 
charger. It comes with power supply adapters for 
Australia, Continental Europe, United Kingdom, 
North America, Central America, Mexico, and 
Japan. The power supply also comes with a flat 
plate for use with an AC power cord (AC power 
cord not included).

2-Bay, 4-Bay, or 
8-Bay Charger

The 2-bay (AC6), 4-bay (AC7), and 8-bay (AC8) 
chargers charge the AB3 battery.

2-Bay, 4-Bay, or 
8-Bay Charger 
Power Supply

This power supply provides AC power to the 2-bay, 
4-bay, and 8-bay chargers.

USB Bluetooth 
Adapter

The USB Bluetooth Adapter (P/N 203-771-xxx) 
provides wireless communications to your host 
computer and data collection application through a 
USB port on your PC.

RS-232 
Bluetooth 
Adapter

The RS-232 Bluetooth Adapter (P/N 203-768-xxx) 
provides wireless communications to your host 
computer and data collection application through 
an RS-232 serial port on your PC.

SR61 Belt 
Holster

The belt holster provides you with an easy way to 
carry the SR61. The holster supports either right-
handed or left-handed use.
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bar code, 22, 27

AIM Standard, Symbology Identifier 
command option, 51

aim, Trigger Mode command option, 54
Aimer Flashing Mode command, 39
area imagers

2D (EA11, SR61xA)
illustration of using, 9
scanning bar codes, 10
specifications, 64

near-far range (EX25, SR61xE)
illustration of using, 9
scanning bar codes, 10
specifications, 66

audio feedback (beeps)
crackle, stacked (2D) bar code, 51
overview, 6
turning off, 7

Australian Post command, 39

autostand, Trigger Mode command 
option, 53

Aztec command, 39

B
bar code symbologies

Australian Post, 39
BPO, 42
Canada Post, 42
Codabar, 43
Codablock A, 43
Codablock F, 43
Code 11, 43
Code 128 / EAN 128, 44
Code 39, 43
Code 93/93i, 43
DataMatrix, 45
Dutch Post, 46
EAN.UCC Composite, 46
Interleaved 2 of 5, 47
ISBT 128, 44
Japan Post, 47
Matrix 2 of 5, 48
Maxicode, 48
MSI, 48
PDF417, 48
Planet, 49
Plessey, 49
Postnet, 49
QR Code, 50
RSS 14, 50
RSS Expanded, 50
RSS Limited, 50
Standard 2 of 5, 51
Telepen, 52
UPC/EAN, 54

bar codes
Administrator Reset Factory 

Defaults, 22, 27
Get Product Version, 26
Get SR61 Bluetooth Device 

Address, 26
Get Sub-System Versions, 26
Limited Discoverable, 23
scanning

configuring SR61, 20
troubleshooting, 28
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bar codes (continued)
setup sheet, described, 19
supported symbologies, 59
symbologies, default, 8

battery, AB3
chargers, described, 67
charging, 3
described, 67
status, checking, 4

Beep Duration command, 40
Beep Frequency command, 40
Beep Volume command, 40
beeps

overview, 6
turning off, 7

belt holster accessory, 67
blue light (Intermec Ready-to-Work 

indicator)
described, 6
illustration, 5

Bluetooth, 38
adapters, USB and RS-232

described, 67
host PCs, connecting to, 16

communications
configuring, 22
connecting as a keyboard wedge, 16
initiating from host device, 22
initiating from your SR61, 22
troubleshooting, 27, 28

discoverable state, configuring, 23
host devices supported, 14
PIN

forgot, troubleshooting, 28
security, configuring, 23

radio
communication range, 58
configuring communication, 22
specifications, 58

security, configuring, 22
SR61 Bluetooth address

how to get, 26
illustration, 14

Bluetooth Connect/Disconnect 
command, 40

Bluetooth Device Disconnect, bar code, 16
Bluetooth Device Name command, 41

Bluetooth Device Page
command, 41
how to find your SR61, 29

Bluetooth Discoverable command, 41
Bluetooth Pageable Mode command, 41
Bluetooth PIN command, 42
Bluetooth Profile command, 42
Bluetooth Security command, 42
BPO command, 42

C
calling Product Support, 26
Canada Post command, 42
chargers, described, 67
charging the battery, 3
China Post, Matrix 2 of 5 setting, 

described, 48
cleaning, scanner window, 32
Codabar command, 43
Codablock A command, 43
Codablock F command, 43
Code 11 command, 43
Code 128 / EAN 128 command

described, 44
function codes, described, 44
GTIN Processing for EAN 128, 44
ISBT 128, 44

Code 39 command, 43
Code 93/93i command, 43
code mark, symbology identifier, 51
collecting data, how to, 18
commands. See configuration commands
communication range, Bluetooth radio, 58
computers

host PC, connecting to
Bluetooth adapters, using, 16
keyboard wedge, as a, 16

supported, 14
configuration commands

described, 39–55
function, listed by, 35–38
using to configure the SR61, 34

Configuration Modes and Utilities 
command, 45

configuring
Bluetooth communications, 22
from your Intermec computer, 21
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configuring (continued)
parameters, 19
security, 22
using EasySet, 19

connecting to a host device
as a keyboard wedge, 16
host PC, 16
Intermec computers, 15
overview, 14

Consecutive Same Read Data Validation 
command, 45

continuous/edge, Trigger Mode, 
described, 53

D
Data Editing command, 45
data transmission settings, configuration 

commands, list of, 35
data, collecting, 18
DataMatrix command, 45
Decode Mode command, 45
default configuration

Administrator Reset Factory Defaults
bar code, 22
command, 39

restoring, 21
values, 35–38

desktop/wallmount charger, 67
Disable All Symbologies command, 46
discoverable state

described, 41
security, configuring, 23

Dutch Post command, 46

E
EA11 2D area imager (SR61xA)

illustration of using, 9
scanning bar codes, 10
specifications, 64

EAN 128, GTIN processing, 44
EAN.UCC Composite command, 46
EasySet

described, 14
using to configure SR61

offline, 20
online, 19

where to download, 8, 14
EL20 laser scanner (SR61xL)

illustration of using, 9
scanning bar codes, 9
specifications, 62

Error Beep command, 46
EV10 1D linear imager (SR61xV)

illustration of using, 9
scanning bar codes, 9
specifications, 60

EX25 near-far range area imager (SR61xE)
illustration of using, 9
scanning bar codes, 10
specifications, 66

F
factory default settings

Administrator Reset Factory Defaults 
command, 39

restoring, 21
firmware

upgrading, 30
version, how to get, 26

flashing, Trigger Mode, described, 53
FNC1 and FNC2, Code 128 / EAN 128 

function code, described, 44
forgot Bluetooth PIN, troubleshooting, 28

G
Get Product Version, bar code, 26
Get SR61 Bluetooth Device Address, bar 

code, 26
Get Sub-System Versions, bar code, 26
Good Read Beep Duration command, 47
Good Read Beep Number command, 47
Good Read Beep Timing command, 47
green light (status light), 5
GTIN processing

EAN 128, 44
UPC/EAN, 55

guide, audience, xi

H
help, calling Intermec, x
holster, belt, accessory, 67
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I
imagers

1D linear (EV10, SR61xV)
illustration of using, 9
scanning bar codes, 9
specifications, 60

2D area (EA11, SR61xA)
illustration of using, 9
scanning bar codes, 10
specifications, 64

near-far range area (EX25, SR61xE)
illustration of using, 9
scanning bar codes, 10
specifications, 66

Interleaved 2 of 5 command, 47
Interlink firmware upgrade application, 

described, 30
Intermec

computers
connecting to, 15
supported, 14
using to configure the SR61, 21

contact information, ii
Ready-to-Work indicator

described, 6
illustration, 5

SmartWedge, described, 16
telephone support, x

ISBT 128 command, 44

J
Japan Post command, 47

K
keyboard wedge

connecting, 16
Intermec SmartWedge, described, 16
Keyport Lite, described, 16
troubleshooting, 28

Keyport Lite, described, 16

L
labels, bar code, scanning, 8
laser scanner (EL20, SR61xL)

illustration of using, 9
scanning bar codes, 9
specifications, 62

ldr, firmware upgrade file, 30

level, Trigger Mode, described, 53
light

blue (Intermec Ready-to-Work 
indicator), 6

red or green (status), 5
Lighting Goal command, 47
limited discoverable

bar code, 23
described, 41

M
Macro PDF417, described, 48
Matrix 2 of 5 command, 48
Maxicode command, 48
MSI command, 48

N
near-far range area imager (EX25, SR61xE)

illustration of using, 9
scanning bar codes, 9, 10
specifications, 66

new features, 3

O
off, turning off SR61, 4
offline, configuring SR61 with EasySet, 20
omni-directional scanning, 10
on, turning on SR61, 4
online, configuring SR61 from EasySet, 19
operating settings, list of, 37

P
paging the SR61, how to, 29
parameters, configuring SR61, 19
patent information, xii
PC, connecting to

Bluetooth adapters, using, 16
keyboard wedge, as a, 16

PDF417 command, 48
Planet command, 49
Plessey command, 49
Postamble command, 49
Postnet command, 49
power down bar code, 4
power supplies, 67
Preamble command, 49
Predefined Security Levels command, 50
problems, finding and solving, 27
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Product Support, calling, 26
product version, how to get, 26
pulse, Trigger Mode, described, 53

Q
QR Code command, 50

R
radio, Bluetooth

communications, configuring, 22
specifications, 58

Ready-to-Work indicator
described, 6
illustration, 5

red light (status light), 5
resetting, SR61

behavior after reset, 29
how to, 29

restoring default settings
Administrator Reset Factory Defaults

command, 39
described, 21

RS-232 Bluetooth adapter
connecting to a host PC, 16
described, 67

RSS 14 command, 50
RSS Expanded command, 50
RSS Limited command, 50

S
scan engine option, how to find, 2
scanner window, cleaning, 32
scanner. See SR61
scanning

bar codes
configuring SR61, 20
how to, 8

omni-directional, 10
troubleshooting, 28

security
Bluetooth PIN, 23
configuring, 22
discoverable state, 23

Sensor Optimization command, 50
Serial Port Profile (SPP), Bluetooth

configuring, 22
described, 42

settings, restoring default, 21
Setup Beep command, 51
SmartWedge, described, 16
sounds (beeps)

overview, 6
turning off, 7

specifications, 58–66
SPP (Serial Port Profile), Bluetooth

configuring, 22
described, 42

SR61
configuring, 19–23
connecting to a host device, 14–18

initiating from the host device, 22
initiating from your SR61, 22

firmware, upgrading, 30
overview, 2

Stacked Code Crackle command, 51
Standard 2 of 5 command, 51
status light, 5
sub-system version, how to get, 26
support, calling Intermec, x
symbologies, bar code

default, 8
list of, 36
supported, 59

Symbology Identifier command, 51

T
Telepen command, 52
Timeout Between Different Consecutive 

Codes commands, 52
Timeout Between Identical Consecutive 

Codes commands, 52
trigger

checking the battery status, 4
troubleshooting, 27
turning on the SR61, 4

Trigger Mode command, 53
Trigger Timeout command, 54
troubleshooting

Bluetooth PIN, forgot, 28
cannot establish a Bluetooth 

connection, 27, 28
guide to finding problems, 27
keyboard wedge mode, 28
resetting the SR61, 29
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troubleshooting (continued)
scanning, 28
trigger, 27

Turn Off After Good Read command, 54
turning on and off, SR61, 4

U
UPC/EAN command, 54

GTIN processing, 55
ISBN, 54

upgrading
how to, 31
what you need, 30

USB Bluetooth adapter
connecting to a host PC, 16
described, 67

User Reset Factory Defaults command, 55

V
Vibrate Alert

command, described, 55
turning on and off, 10

Vibrate Alert Duration command, 55
volume, adjusting, 40

W
wedge, keyboard

connecting, 16
Intermec SmartWedge, described, 16
Keyport Lite, described, 16
troubleshooting, 28

what’s new, 3
wireless communications, configuring, 22
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